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Пришла весна на дворе играли ребята. Они играли с собакой, но потом пришла кошка и тоже захотела с ними поиграть. Но собака была против, она хотела, чтобы ребята играли только с ней. Свое недовольство собака выразила кошке, и они начали драться. Шла жесткая драка между кошкой и собакой. Ребята не знали, что делать и позвали милиционера. Милиционер сначала удивился увидев драку между собакой и кошки. Но потом понял, что хорошим это дело не закончится, и решил дать этому делу конец. Он вытащил свой черный пистолет и вежливо попросил, чтобы они прекратили. Звери послушали милиционера. Дядя милиционер забрал их обоих в отделение. В отделении они написали заявление и обещали, что больше не будут так делать. Им было очень стыдно, когда они пришли обратно на двор, попросили у ребят прощение. И теперь они все дружно играют всем коллективом. Вот так дорогие друзья, будьте счастливы и не обижаете никого.

[bookmark: _Toc421109774]Введение

Для изменения формы металла инженерам требуется пластический расчет конструкции. Существует несколько видов деформации для расчета конструкции. Мы выберем пластическую деформацию, потому что пластическая деформация обладает рядом преимуществ. Главными достоинствами пластической деформации являются: хорошее соответствие действительной работе; одинаковая безопасность для элементов конструкций и самой конструкции; упрощение статических расчетов для ряда конструкций; экономия денежных средств.
	Целью данной дипломной работы является расчет конструкций с учетом пластических деформаций.
	Для достижения этой цели необходимо решить следующие задачи:
1. Изучить теоретические и методические материалы по теории пластичности.
2. Аналитически найти приложенное давление для решения задачи.
3. Провести расчет конструкции в «ППП ANSYS» с учетом пластических деформаций. 



	



Жил был Иван дурак. Он жил в старой общежитии. Однажды к нему заселили одного молодого и у много принца Льва. Они начали жить вдвоем. И вот однажды к ним пришел друг Льва Петрович, а вслед за ним Сергей и вот они начали жить вместе. Но в один прекрасный день Петрович влюбился и решил познакомить свою возлюбленную своим братьям. Возлюбленную Петровича звали Петровна. Петровна была против знакомству с братьями Петровича, но Петрович настаивал этому. И в итоге они начали жить впятером. Они каждый день ссорились, но к счастью среди них был умный и молодой Лев. Он всегда поддерживал и мерил своих друзей. Благодаря Льву ребята начали жить дружно.
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Для единицы объема упругого тела, ориентированного вдоль произвольно выбранной декартовый системы координат х, y, z, удельная потенциальная энергия деформации записывается в виде


 		    (1.1)	
	Введем вектор напряжений {Ϭ} и вектор деформаций {ɛ}



	 	                                  (1.2)
	Тогда выражение W можем записать в виде:

						    (1.3)
Потенциальная энергия деформации, накопившаяся всем телом, находится в виде интеграла по всему объему тела V

					    (1.4)
Закон Гука можем записать в виде матрицы через матрицу упругости [D] 

								    (1.5)
Тогда потенциальная энергия деформации записывается в следующем виде

							    (1.6)
В виде матрицы можно записать также работу внешних сил. Для этого нужно ввести вектор перемещений

								    (1.7)
где u, v, w – проекции вектора перемещений вдоль осей x, y, z вектор массовых сил {Q}

	
и вектор поверхностных сил {P}, который действует на части поверхности SϬ,


Тогда работу внешних сил можем записать в виде


 	
	Полная энергия (Функционал Лагранжа) системы определяется следующим образом


если учесть  (1.6) и (1.10), то получаем окончательное выражение 

 


	           В соответствии с общими теоремами механики, минимум полной энергии соответствует истинному состоянию равновесия тела, то есть задача сводится к поиску вектора, и вектора, которые дают min L. Статические граничные условия и уравнения равновесия являются уравнениями Эйлера этой вариационной задачи.
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Пусть  – радиус-вектор произвольной материальной точки в недеформированном состоянии;  – радиус-вектор этой же точки, но в деформированном состоянии;   – вектор перемещений;  – вектор скорости.
Основополагающую роль в кинематике конечных деформаций играет тензор градиента деформации:

		(2.1)
В качестве тензоров, описывающих деформацию и скорость деформации, мы будем использовать:
· меру деформации Коши-Грина (правый тензор Коши-Грина)

		(2.2)
· меру деформации Фингера (левый тензор Коши-Грина)

		(2.3)
· пространственный градиент скорости

		(2.4)
· тензор деформации скорости

	,	(2.5)
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Введем следующие обозначения главных инвариантов тензора :

		(2.6)

Относительное изменение объема обозначим через 
Напряженное состояние описывается с помощью:
1. тензора истинных напряжений, определенного в актуальном состоянии 

		(2.7)
1. тензора напряжений Лагранжа 

		(2.8)
1. второго тензора напряжений Пиолы-Кирхгофа

		(2.9)
Используем, как основное, вариационное уравнение принципа виртуальных мощностей в актуальной конфигурации:

		(2.10)




где – вектор скорости материальной точки; – текущий объем; – часть поверхности, на которой заданы усилия; – векторы поверхностных и объемных сил соответственно.
Линеаризуем последнее уравнение:

		(2.11)

		(2.12)

		(2.13)
Окончательно получим уравнение в скоростях напряжений Коши-Эйлера:
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 	Упругопластическое деформирование толстостенной трубы (пластины)


	Исследуем распределение напряжений в толстостенной длинной трубе под осесимметричным внутренним давлением p при упругопластичном деформировании (рис. 1) в геометрически линейной постановке (плоская задача). Внутренний радиус трубы = 2 см, внешний =5 см, модуль упругости Е = 2000000 кг/см2; коэффициент Пуассона µ =0.3. Материал полагаем идеально пластическим, критерием пластичности служит условие Губера – Мизеса. 
Из аналитического решения было найдено отношение внутреннего давления к пределу текучести   p/ϬТ = 0.7209, при котором радиус пластической зоны rТ = 3.5 см.
[image: ]
                                                    Рис.1.
Так как задача обладает двумя плоскостями симметрии, то рассматривалась четверть трубы со следующими граничными условиями: нижняя грань не имеет вертикальных смещений, а боковая – горизонтальных (рис.2), в силу того, что задача плоская, исключаем осевые смещения всех узлов.
                                     	[image: ]
                                                                Рис. 2.
	В силу того, что пренебрегаем большими перемещениями и деформациями, задача решается за один шаг по нагрузке, при этом используется метод проецирование напряжений на поверхность текучести с итерационным уточнением. Для определения эффективности методики моделирования упругопластического деформирования исследовалась сходимость при различных сетках конечных элементов, и полученные значения сравнивались с теоритическим решением. Использовались следующие сетки конечных элементов: труба разбивалась на 5 элементов по ширине и 20 элементов по окружному исправлению (рис.3), далее – 20х20 (рис.4) и 80х20 (рис.5)


[image: ][image: ]

                            Рис.3.                                                                                Рис.4.                 

                                                  [image: ]
                                                                               Рис.5.
	Далее задача была решена с учетом геометрической нелинейности с использованием сетки конечных элементов размером 40х20. При этом варьировался модуль упругости Е, а величина внутреннего давления р подбиралась таким образом, чтобы радиус пластической зоны соответствовал с = 1.5 см. Нагрузка была разделена на 50 шагов.


          
Глава 4.Аналитическое нахождение приложенного давления
[image: ]                     
                          
                           ϬТ = 240 МПа;
                            r1 = 5 см; 
                      r2 = 2 см; 
                      rТ = 3.5 см.
           


                Рис.7.   

	Уравнение, связывающее радиус границы, отделяющее радиус границы, отделяющей упругого область от пластической, и приложенное давление:

                               




                            
                         Отношение внутреннего давления к пределу текучести:
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1) Зайти в Ansys Main Menu-> Preprocessor->Modeling Create->Cylinder->Partial Cylinder.Таким образом мы построим часть нашей трубы.
2) Выбираем тип элемента. Для этого выбираем: Preprocessor->Element Type->Add/Edit/Delete->Add->Solid 182
3) После задаём модуль Юнга и коэффициент Пуассона, используя команду Preprocessor-> Material Props->Material models->Structural->Linear->Elastic. После в графе EX пишем значение модуля Юнга, а в графе PRXY коэффициент Пуассона.
4) Зададим предел текучести для этого выберем: Preprocessor-> Material Props->Material models ->Structural->Nonlinear->Inelastic->Isotropic Hardening->Bilinear. В графу Yield Sts вписываем предел текучести.
5) Задаём разбиение и густоту сетки. В Preprocessor выбираем вкладку Meshtool. Во вкладке Size Controls выбираем Areas->Set->Pick All. После этого выбираем Mesh->Pick All. Конструкция разбита на конечные элементы.
[image: ]
Рис.8. Конструкция, разбитая на конечные элементы

6) Теперь зададим условия закрепления для нижней грани, выбрав Solution->Loads Apply->Displacement->On Lines-> Uy
7) Теперь зададим условия закрепления для верхней грани, выбрав Solution->Loads Apply->Displacement->On Lines->Ux.[image: ]
Рис.9. Конструкция после условия закрепления


8) Зададим распределённую нагрузку на линию: Solution->Loads Apply->Preassure->On lines.
9) Запуск на решение в Solution->Solve Current LS. Если появилась иконка Solution is Done, то задача решена.
10) Построим эпюры и таблицы напряжений. Для этого выбираем General Postproc->Plot results->Nodal Solution. И далее выбираем эпюры напряжений которые нас интересуют (Sx,Sy,Sxy,von Mises).
[image: ]
Рис.9.Напряжения по оси Х

[image: ]
Рис.10.Напряжения по оси У
              [image: ]
                      		Рис.11.Суммарные напряжения 

[image: ]
                                               Рис.12.Напряжения «von Mises»
[image: ]
Рис.13. Пластическая деформация




Жил был Иван дурак и мудрый Лев. Однажды Ивану поручили очень важное дело. Иван дурак всегда думал, что он умнее всех остальных, но ему это только казалось. Он сел за дело и начал работать, но у него ничего не получалось и в итоге он ничего не сделал. Благодаря своему брату Льву он закончил свое дело и попросил у брата прощение. Они жили долго и счастливо. Спустя много лет они поженились и у них было много детей. Они жили долго и счастливо.
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/COM,   
/COM, Preferences for GUI filtering have been set to display:
/COM,  Structural   
!*  
/PREP7  
CYL4,0,0,0.5,0,1,90 
/DIST,1,1.08222638492,1 
/REP,FAST   
/DIST,1,1.08222638492,1 
/REP,FAST   
/DIST,1,1.08222638492,1 
/REP,FAST   
/USER,  1   
/FOC,   1,  0.495817188407    ,  0.507319920288    ,   0.00000000000
/REPLO  
/VIEW,  1, -0.902893759668    , -0.109082413035    ,  0.415793080653
/ANG,   1,   7.71518225753  
/REPLO  
/VIEW,  1,  0.211927308702E-01,  0.874419932865E-01,  0.995944158057
/ANG,   1,   6.42922551844  
/REPLO  
/VIEW,1,,,1 
/ANG,1  
/REP,FAST   
ET,1,PLANE182  
MPTEMP,,,,,,,,  
MPTEMP,1,0  
MPDATA,EX,1,,2e11   
MPDATA,PRXY,1,,0.3  
!*  
TB,BISO,1,1,2,  
TBTEMP,0
TBDATA,,240e6,,,,,   
!*  
ACLEAR,       1 
GPLOT   
FLST,2,1,5,ORDE,1   
FITEM,2,1   
AESIZE,P51X,15, 
CM,_Y,AREA  
ASEL, , , ,       1 
CM,_Y1,AREA 
CHKMSH,'AREA'   
CMSEL,S,_Y  
!*  
AMESH,_Y1   
!*  
CMDELE,_Y   
CMDELE,_Y1  
CMDELE,_Y2  
!*  
ACLEAR,       1 
GPLOT   
FLST,5,4,4,ORDE,2   
FITEM,5,1   
FITEM,5,-4  
CM,_Y,LINE  
LSEL, , , ,P51X 
CM,_Y1,LINE 
CMSEL,,_Y   
!*  
LESIZE,_Y1, , ,25, , , , ,1 
!*  
MSHKEY,1
!*  
CM,_Y,AREA  
ASEL, , , ,       1 
CM,_Y1,AREA 
CHKMSH,'AREA'   
CMSEL,S,_Y  
!*  
AMESH,_Y1   
!*  
CMDELE,_Y   
CMDELE,_Y1  
CMDELE,_Y2  
!*  
/DIST,1,0.729,1 
/REP,FAST   
/DIST,1,0.729,1 
/REP,FAST   
/DIST,1,1.37174211248,1 
/REP,FAST   
/DIST,1,1.37174211248,1 
/REP,FAST   
/DIST,1,1.37174211248,1 
/REP,FAST   
FINISH  
/SOL
FLST,2,1,4,ORDE,1   
FITEM,2,2   
!*  
/GO 
DL,P51X, ,UX,   
FLST,2,1,4,ORDE,1   
FITEM,2,4   
!*  
/GO 
DL,P51X, ,UY,   
FLST,2,1,4,ORDE,1   
FITEM,2,3   
/GO 
!*  
SFL,P51X,PRES,176e6,   
FINISH  
 /SOL
/STATUS,SOLU
SOLVE   
FINISH  
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В процессе выполнения дипломного проекта был проведен расчет конструкции с учетом пластических деформаций. Исследование показало, что при уменьшении жесткости материала, величина внутреннего давления, необходимо для появления заданной области пластичности, также убывает, а труба все более расширяется. В частности, ее диаметр существенно изменяется, а толщина уменьшается. Также отметим, что при решении задачи с учетом конечных деформаций, перемещений и поворотов, в отличие от геометрически линейной постановки, величина внутреннего давления также падает.
Таким образом, задачи решены в полном объеме и поставленная цель достигнута.


На улице стоял прекрасная погода. Мальчик решил выйти на улицу и поиграть с детьми. Он попросил у мамы и вышел на улицу. В один прекрасный момент он увидел собаку, которая помогала бабушке переходить улицу. Он подумал и решил, что тоже хочет помогать людям, но он не знал с чего начать. И вот внезапно он увидел дедушку, который шел по тротуару с большими сумками. Он подошел к дедушке и предложил свою помощь. Дедушка обрадовался, ведь не многие готовы помощь людям в этой жизни. Вот так маленький мальчик порадовал и себя, и дедушку, и своих родных. В этой жизни надо помогать людям и ваша помощь возвратится к вам в тяжелые минуты.










[bookmark: _Toc421109781]Список использованной литературы

1. Конюхов А.В. Основы анализа конструкций в ANSYS / А.В. Конюхов. – Казань: Изд-во КГУ, 2001. – 101с.
2. Малинин Н.Н. Прикладная теория пластичности и ползучести / Н.Н. Малинин. – Москва: Изд-во «Машиностроение», 1975. – 400 с.
3. Басов К.А. ANSYS. Справочник пользователя / К.А. Басов. – Москва: Изд-во ДМК Пресс, 2011. – 640с.
4. Огородникова О.М. Конструкционный анализ в среде ANSYS / О.М. Огородникова. – Екатеринбург: Изд-во УГТУ-УПИ, 2004. – 68с.
5. Голованов А.И. Математические модели вычислительной нелинейной механики / А.И. Голованов, Л.У. Султанов. – Казань: Изд-во КГУ, 2009. – 465 с.
Пришла весна. На улице стояла прекрасная погода. Все ребята играли на улице, только мальчик по имени Иван сидел дома и грустил. Однажды он тоже решил выйти на улицу и поиграть с остальными детьми, когда он вышел на улицу он обратил внимание на пробегавшую мимо девушку. Она была необычайно привлекательна. Глаза ее были темные как ночь и сверкали как звезды. Иван влюбился с первого взгляда. Иван не знал, что с ним происходит. Его тело дребезжало от любви. Он не знал, как сказать об этом той девушке и обратился к своему деду. Его дед был величайшим любовным мастером в городе. Дедушка подсказал внуку что делать и Иван познакомился с той девушкой. Они поженились и жили долго и счастливо. 
Жил – был мужик. У него был конь. Он каждый день работал со своим конем в поле. Этот мужик был очень трудолюбивым и честным. Он работал с утра до вечера каждый день. В один прекрасный день он нашел в поле сундук с сокровищами. Он очень обрадовался. Мужик начал думать на что он будет тратить эти. В итоге он сначала построил большой дом, купил новую тележку для коня и женился. Мужик начал жить хорошо и красиво, но в один прекрасный день его жена заявила, что им не нужен конь и приказывала прогнать коня на улицу. Мужик не знал, что делать, ведь благодаря именно своему коню он добился всему, что у него есть. Он не хотел прогнать коня на улицу и решил спрятать его в сарае. На следующий день его жена нашла коня в сарае и сказала своему мужу выбрать между женой и конем. Мужик не знал, что делать. Он умолял Бога вернуть те дни когда он работал с конем в поле вдвоем. Потому что именно тогда он был по настоящему счастлив. Мужик лег спать и когда уже проснулся все было по другому. Он заново начал работать в поле со своим конем в поле и был по настоящему счастлив, потому что он познал свое счастье только тогда, когда потерял его. Вот так дорогие друзья! Цените свое счастье, ведь если не ценить, то можно потерять то, что у вас в руках.
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